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1 Getting started

If you already own Dental Explorer 2, the first thing you should do is to transfer your 
patient database to your new program. Next, you should set up the software so that best 
meets your needs. The following two sections tell you everything about how to do this.

1.1              Importing data from Dental Explorer Version 2  

In a network installation, you must import the patient data on the server only. To begin, 
close Dental Explorer 3D on the server and on all clients. Then click on

Programs > DE3D > Patient Data Import Converter.

Now click on "Import Data Version 2.0, 2.1". You may have navigate to the "database" 
folder of Dental Explorer Version 2 if it is not already displayed. Exactly where this folder is 
located will depend on your installation of Dental Explorer 2. In the "database" folder, 
select the PATIENT.V12 file and then click "Open".
Re-save the PATIENT.V12 file under the proposed name DE DATA EXPORT.XML in the 
same directory. Close the database conversion program and start Dental Explorer 3D.
From the main menu, select Help > Import DE 2.0. Navigate to the "database" folder of 
Dental Explorer Version 2 and select the DATA DE EXPORT.XML file you just created. Click 
"Open". Wait while your patient information is imported.

1.2              Configuring Dental Explorer 3D  

Please take a few minutes to configure Dental Explorer 3D. All relevant operations can be 
found under the "Settings" menu item. There are three ways to get to the Settings 
window:

• Click on the  icon near the left edge of the screen
• (Under Windows:) Press the F11 function key
• From the "Window" menu, select "Settings"

At the top of the Settings window you will see three tabs: "General", "Appearance" and 
"Screenshot settings".
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1.2.1           General  

Here you will see some flag icons that allow you select a different user interface language 
for Dental Explorer 3D. By clicking on the appropriate flag symbol, you can choose 
between English, French, German, Italian, Portuguese or Spanish. 

Note: Videos can always be played back in any language, regardless of the current 
interface setting.

Below the flag symbols, there are six options you can enable or disable: 

Show title bar: If this option is enabled, each window in Dental Explorer 3D will have its 
own title bar and controls and can be detached from the main window. Be sure to read 
section 16 of this manual before choosing this option.

Vertical tabs: This option which you control whether the tabs used to switch between 
panes in "Zone 6" (see the following section 4 a description of zones) should be displayed 
along the bottom or along the right edge of the screen.

3D auto-rotate: If this option is checked, it is sufficient to "push" the 3D model slightly to 
cause it to move steadily.

3D auto-centre restoration: Checking this option automatically zooms the appropriate 
tooth in the centre of the window if a restoration was placed there using the dental chart.

Preview on/off: Checking this option opens a second, smaller 3D window below the 
restoration selection where a single tooth will be shown as restored by the selected 
restoration. If you prefer to see a complete restoration menu wherever possible, do not 
check this option.

Do not show the startup screen again: If you do not want to be prompted at program start 
as to whether to use the high-resolution, low-resolution or 2D, simply check this option.
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1.2.2           Appearance  

Here you can change the basic style (user interface colour). Some of the controls may 
change accordingly. You have a choice between various grey or blue hues and a shade of 
green. Feel free to experiment until you get the program look you find most pleasing. 

You can also influence the behaviour of the restoration menu. Here, too, you may wish to 
experiment a bit until you are pleased with the behaviour of the restoration menu.

1.2.3           Screenshot settings  

"Resolution" lets you control the size of the screenshot.

For "Camera", you have a choice between "Perspective" (with spatial distortion) and 
"Parallel view" (with no spatial distortion).

For "Light", you have a choice between "Direct", "Dot" and "Spot". 

For "Rendering quality", you can control the smoothing (anti-aliasing) behaviour and the 
number of passes. The more passes you allow, the better the quality of the screenshots, 
but the trade-off is that it can take a little longer.

The program as shipped comes with screenshot settings preconfigured in a way that you 
should not have to make any changes in most environments.

1.3              Tutorials  

Several tutorials are available to help you become familiar with the program and its 
controls. However, you will not find these on your DVD; they reside on the Internet at 
www.dentalexplorer.de.
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2 Program overview

The Dental Explorer 3D screen is divided into six "zones":

Zone 1 presents the main menu of the program. As with most programs, you can click on 
a selection to open a dropdown menu with various program-related functions. Each 
function or menu item is selected by simply clicking on it.

Zone 2 presents the most important program functions in easily remembered icon form. 
Click on the appropriate icon to activate the corresponding function directly.
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Zone 3 presents all the controls you need to display and manipulate views, e.g. showing 
and hiding gingiva or bone, selecting a different viewing angle, rotating, zooming and 
more. Note that the controls available in 3D view are not the same as those available in 
2D view.

Zone 4 is the main window of Dental Explorer. It will display the results of all your actions 
immediately.

Zone 5 presents the so-called picture flow. It collects all your screenshots of the main 
window (zone 4) that you save and keeps them available for later processing.

Zone 6 presents various types of context-dependent information in the form of stacked 
panes. Click the appropriate tabs to alternate between panes. In most cases you will wish 
to use zone 6 to display the restorations and the restoration preview. Another important 
purpose of this zone is to view/save/find patient information. There are also switching 
options for viewing or activating your examples, your documents and the videos. A 
separate pane is provided for settings.
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3 Icon bar overview

The following table briefly describes the icons and their functions. For more information, 
please consult the appropriate sections of this User Manual.

Note: Function keys are not available on Macintosh.

Section   F key

Switch to 3D view 5 F3

Switch to 2D view 6 F2

Display patient information 7 F4

Display and select available examples 10 F5

Display and select available videos 9 F6

Display and select available documents 8 F8

Activate the Timer function 11 F9

Visit the Dental Explorer website on the Internet 12 F10

Display help F1

Change settings 1.2 F11

Exit program
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4 Typical tasks and workflows

For users in a hurry:
• Designing a restoration on-screen without saving 
• Displaying various background information videos

For users with multiple treatment rooms:
• Creating a patient record
• Designing multiple restoration alternatives and saving them with the patient record
• Retrieval of the patient record the next time the patient returns

For installations connected to practice management software:
• Importing a patient status created by the office management software
• Designing multiple restoration alternatives/treatment plans

For situations with recurring standard workflows:
• Retrieval of previously designed examples
• Modifying these examples by successively adding construction steps
• Saving the resulting treatment alternatives with the patient record

For patients requiring more comprehensive information:
• Designing a (possibly complex) restoration
• Creating various screenshots of the restoration in 2D and 3D
• Collecting these screenshots in the "picture flow"
• Inserting the images from the picture flow into one of the document templates 

supplied
• Printing the customized document template

For case documentation, e.g. for health insurers:
• Designing a (possibly complex) restoration
• Creating various screenshots of the restoration in 2D and 3D
• Collecting these screenshots in the "picture flow"
• Highlighting and documenting relevant facts using the "paint" functions
• Inserting the images from the picture flow into a custom text document
• Adding medical reasoning and expertise to the document
• Printing the completely assembled document

For users familiar with Dental Explorer 2D:
• Continue designing in 2D as usual
• Switch to 3D view at a click of the a mouse
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5 Dental Explorer 3D

To activate the 3D features of Dental Explorer, click on the  icon or press the F3 
function key or open the "Window" menu and select "3D restorations".

The program will perform a number of actions:

• The main window (zone 4; see section 2) will display a three-dimensional view.
• The context-sensitive control bar (zone 3) will display those controls (buttons) you 

need to work in 3D view.
• The right part of the screen (zone 6) will automatically show the restoration menu 

with the dental chart.

5.1              The control bar in 3D view  

The buttons of the control bar are arranged in groups to make the one you need easy to 
find despite the large number of buttons. (However, the separating space will be visible 
only if your screen has a horizontal resolution of more than 1024 pixels.) After having 
worked with the control bar for some time, you will realize that the button arrangement 
has been optimized for your daily work:

Group 1: Group 2: Group 3: Group 4:

Anatomy controls Viewing angle controls Tooth-related controls 
and 3D view controls

Miscellaneous 
controls

For added convenience, all controls that serve no function in a given context will be 
greyed out. Only those buttons that are active are highlighted.
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5.1.1           Anatomy controls  

The anatomy controls will let you do the following, separately for each jaw:

• Show or hide the gingiva

• Show or hide the bone

• Show or hide the teeth

For example, to display only the teeth, cervical areas and roots, click once on the 
"Gingiva" control and once on the "Bone" control. You can create different views for the 
maxilla and the mandible.

Clicking the same control one more time, the original display status will be restored. If the 
gingiva had been hidden, it will become visible; if it had been shown, it will be hidden.
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5.1.2           Viewing angle controls  

To let you work faster, different viewing angles have been predefined to save you the 
trouble of rotating the model manually. The following viewing angles are available: 

• Maxilla, occlusal view

• Left lateral view

• Right lateral view

• Mandible, occlusal view

• Frontal view

• Slightly inclined 3D view

• Reset model to its original size

Note that a relationship exists between the anatomy controls and the viewing angles. For 
example, if you have chosen to hide the entire maxilla (gingiva, bone, teeth) and then 
select a left or right lateral view, still only the mandible will be displayed. The maxillary 
anatomy will not be shown until you click the maxillary anatomy buttons.

The  button has a special function. It is in fact four separate controls that allow you 
to store and retrieve your viewing angles. Proceed as follows:

To save a viewing angle, move the model into the desired position. Guide the mouse 
pointer over one of the numbers and hold the left mouse button depressed for at least two 
seconds. Nothing will change on the screen because the viewing angle stored is the one 
currently displayed.

To retrieve a stored viewing angle, briefly click the corresponding number. The model on 
the screen will now rotate to the previously saved viewing angle automatically.
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5.1.3           Tooth-related controls  

These controls include the selection button, the animation button, the centring button and 
the transparency slider.

Use the selection button to toggle between the "Connect restoration" and 
"Animate restoration" functions.

Deactivated: Restorations can be connected to the tooth only by clicking a 
tooth in the dental chart. Existing restorations can be animated. 

Activated: Restorations can additionally be connected directly to the 3D 
model.

Note: Keeping the Shift key pressed will let you activate multiple teeth in 
sequence, so that e.g. any bridges designed can be lifted off step by step in a 
subsequent animation.

The Animate button is very important to ensure that patients understand the 
implications of their treatment. This button allows you to assemble and 
unassemble complete groups of objects (exploded view). You can take 
situations apart and put them back together to demonstrate for your patients 
what they look like inside. Click a tooth in the main window and finally the 
Animate button. Some of the many possibilities this gives you include:
– Lifting off a crown and visualizing the crown preparation
– Pulling apart an implant and presenting its components
– Lifting off prosthetic restorations as a whole

The Centre button is required if you want to put a specific tooth, restoration or 
special animation "in focus". Click a tooth or restoration in the main window 
and finally the Centre button. The view will be enlarged, and the selected 
tooth will be displayed in the middle of the main window.

Clicking this button will reset the tooth selection.

The transparency slider helps you visualize the "innards" of a restoration. Click 
the selection arrow, then a tooth in the main window and then slide the 
transparency slider forward or back. You can also make the surrounding bone 
transparent to show how the tooth roots and/or implants are anchored within 
the bone.
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5.1.4           3D view controls  

Click this button to activate Rotate mode. Move the mouse pointer to the 
dentition, keep the left mouse button pressed and rotate the model to the 
desired viewing angle. If the 3D auto-rotate option (in the settings) is 
checked, it is sufficient to "push" the dentition slightly to cause it to move 
steadily.

Click this button to activate Zoom mode. Move the mouse pointer to the 
dentition, keep the left mouse button pressed and zoom in or zoom out by 
pulling the mouse towards you or pushing it away from you, respectively.
Note: If you have a mouse with a scroll wheel, you can zoom in or out the 
model by turning this wheel.

Click this button to activate Move mode. Move the mouse pointer to the 
dentition, keep the left mouse button pressed and push the model in the 
desired direction.
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5.1.5           Miscellaneous controls  

The controls on the right side of the bar have the following functions:

Undo: Clicking this button lets you go back one step and undoes the effect of 
your previous action.

Redo: Clicking this button restores the effect of an action previously undone.

Resetting the entire dentition: Clicking this button removes all restorations 
previously connected to the teeth. Caution: This action cannot be undone!

Save: The current restoration is stored with the patient record or as an 
example. For more details please consult sections 7.5 and 10.1.

Screenshot: The current restoration is added to the image collection. For more 
details please consult section 13.

Switch windows: Clicking this button swaps the contents of the main window 
and the restoration preview (below the restoration menu). 
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5.2              Restoration menu and dental chart  

Both in 2D more and in 3D mode, the upper third of the screen will contain the dental 
chart, the middle part will contain the dental restorations, and the lower part (unless 
deactivated in the settings) will contain an additional, smaller 3D window for previewing 
the selected restoration.

The list of dental restorations is dynamic, that is, it will open at the restorations you 
selected. For example, when you click on "Crown", you will see the selections "Cast-
metal", "Metal-ceramic", "With post-and-core" and "3/4 crown" displayed directly 
underneath. If you proceed to clicking on "Cast-metal", the additional selections "Silver-
coloured", "Gold" and "Ceramics" will appear. Clicking on "Gold" provides no additional 
selections, as you have come to the end of the selection tree. Instead, the preview 
window will display a gold crown, which you can rotate in all directions or make spin by 
pressing and holding the left mouse button.

Dynamic lists ensure that you know where you are at all times and that you cannot select 
any combinations that make no sense from a medical point of view.

Visualizing a restoration is very simple:

• Select a restoration from the list
• Click on the tooth in the dental chart to which you want to connect this restoration.

The main window now displays the restoration, and the dental chart shows a symbol for 
the restoration selected. If you move your mouse pointer over the dental chart and point 
at the various teeth, you will see the corresponding tooth designation below the dental 
chart and a detailed description of the selected restoration:

Note that the program does not allow implausible combination. Teeth to which you cannot 
connect the selected restoration are greyed out on the dental chart.
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5.3              Hybrid view  

For additional ease of handling, Dental Explorer 3D will use the so-called hybrid view for 
hybrid restorations (cast-metal framework dentures, complete dentures and implant-
supported prostheses). These complex restorations are presented as examples from a 
reference library, covering most clinically relevant cases. These reference examples save 
you time when designing the most common types of restoration, as they is no need to 
tediously compose them from their individual components.

When a hybrid restoration is selected, the upper edge of the main window will display an 
additional control bar with a control element that lets you toggle between normal and 
hybrid view, the so-called Hybrid button. In normal view, this button will be green. In 
hybrid view, this button will be orange:

  

In addition, the title of the control bar indicates which view mode is currently active.

To return to normal view after selecting a hybrid restoration, simply click the Hybrid 
button. Toggling back to normal view also lets you provide a restoration based on 
treatment categories (Germany) for a jaw that does not have a hybrid restoration.

You may also save your planning data for full-mouth restorations (which may contain 
standard and/or hybrid restorations) as an example. If you load an example (as explained 
in section 10), the first restoration you will see will be a hybrid restoration, if available. You 
may now use the hybrid button to toggle back to normal view for restorations based on 
treatment categories.

Note: When using the Dental Explorer 3D data interface (see section 17), note that the 
hybrid restorations shown are reference examples based on treatment categories 
(Germany). The examples shown will always be those that come closest to the transmitted 
individual findings or treatment planning.

Like other restorations, hybrid restorations can be rotated, zoomed and animated as 
described in sections 5.1.3 and 5.1.4. This will give your patients a better understanding of 
these complex restoration types.
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6 Dental Explorer 2D

To activate the 2D features of Dental Explorer, click on the  icon or press the F2 
function key or open the "Window" menu and select "2D restorations".

The program will perform a number of actions:

• The main window (zone 4; see section 2) will display a two-dimensional view.
• The context-sensitive control bar (zone 3) will display those controls (buttons) you 

need to work in 2D view.
• The right part of the screen (zone 6) will automatically show the restoration menu 

with the dental chart.

6.1              The control bar in 2D view  

Not surprisingly, this control bar does not control as many controls as that for 3D view. For 
example, the anatomy buttons are missing; jaws are invariably presented complete with 
the gingiva. On the left you will see the controls for changing the viewing angle. On the 
right, you will see other controls identical to those on the 3D control bar. Users who have 
worked with the previous version of the software will get their bearings very soon.
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6.1.1           Viewing angle controls  

Click one of these buttons to alternate between different views. The following viewing 
angles are available:

• Maxilla, occlusal view

• Maxilla, right lateral view

• Maxilla, left lateral view

• Maxilla, frontal view

• Mandible, occlusal view

• Mandible, left lateral view

• Mandible, right lateral view

• Mandible, frontal view
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6.1.2           Miscellaneous controls  

The controls on the right side of the bar have the following functions:

Undo: Clicking this button lets you go back one step and undoes the effect of 
your previous action.

Redo: Clicking this button restores the effect of an action previously undone.

Reset: Clicking this button removes all restorations previously connected to the 
teeth. 
Caution: This action cannot be undone!

Save: The current restoration is stored with the patient record or as an 
example. For more details please consult sections 7.5 and 10.1.

Print: The current restoration in the 2D window is printed. For more details 
please consult section 15.

Screenshot: The current restoration is added to the image collection. For more 
details please consult section 13.

Two sliders are located between the main window and the control bar that you can use to 
resize and rotate the model/restoration in the main window.

6.2              Restoration menu and dental chart  

The options on the Restoration menu and the dental chart are nearly identical with those 
for 3D, described in section 5.2. There is one exception: Unlike the procedure in 3D view, 
you can always connect the restoration by selecting it and clicking directly on the tooth 
rather than on the dental chart.

6.3              Hybrid view  

The procedures and options in hybrid view are identical with those described in section 
5.3.
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7 Managing patient data

To manage your patient data, click the  icon or press the F4 function key or open 
the "Window" menu and select "Patients". Patient data administrative includes storing 
patient data and assigning a potentially unlimited number of restorations.

Patient data are stored in a database, which in a new installation of Dental Explorer will of 
course still be empty. If you have previously worked with Dental Explorer 2D, we 
recommend importing the patient data from the earlier product before manually entering 
additional patient data. For more information about this procedure, please consult section 
1.1.

The right part of the screen contains a number of fields. These fields let you enter 
essential data and miscellaneous information about the patient. To begin with, enter at 
least the first/given name and the last/family name of the patient so you can identify the 
patient record later.

7.1              Creating a new patient record  

Click the  button. In the data entry mask, which now contains only empty input fields, 
enter at least the patient's first/given name and last/family name. The new patient record 
will be added to the end of the database table. Database records are saved automatically.

7.2              Navigating patient records  

Use the arrow buttons to move between patient records:

Go to the first patient record

Go to the previous patient record

Go to the next patient record

Go to the last patient record
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If you have created many patient records, it is advisable to use the search function instead 
of navigating with the arrow symbols.

7.3              Searching for a patient  

Click the  button. A search field will open. As long as you do not have anything typed 
in the search field, you will see the complete list of patients in the database at the top of 
the screen.

Begin entering your search term in the search field, letter by letter. The list will get shorter 
and display only those entries that match the characters typed in the search field. As soon 
as you see the record you are looking for, you can copy it to the patient data area by 
double-clicking it.

If you have checked the case-sensitive option, the search will only find those patient 
records that match your search term exactly.

The drop-down menu on the right should usually be set to "Word-initial". In some cases, 
however it can be helpful to change this setting to "Whole word" or "Regular expression". 
For example, if you are not sure whether your patient's name is spelled John or Jon, you 
would select "Regular expression" and enter "J*n" in the search field.

Please note that your entries and your search settings will be stored for the next search 
for your convenience. If you want to change an entry or any of your settings, the quickest 
way to do this is to click behind the search term in the input field to place the cursor at its 
end and press the Backspace key once or repeatedly.

7.4              Deleting a patient record  

To delete a patient record, click the  button. You will be prompted for confirmation 
before the record is actually deleted. Note that any restorations associated with the 
patient record to be deleted will also be removed.
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7.5              Assigning a restoration to a patient  

If a restoration is to be assigned to the patient, both the patient record and the restoration 
must previously exist. It does not matter whether you create the patient record first or 
construct the restoration first.

In the "Patients" pane, click the  button. You will be asked under what name you 
want to save the restoration for the patient. Try entering a meaningful name that lets you 
distinguish different alternatives later.

An unlimited number of restorations on treatment alternatives can be stored for each 
patient record. This will help you and the patient compare different variations on the same 
restorative theme (e.g. fillings with different materials or bridges vs. implant-supported 
restorations).

7.6              Retrieving a restoration assigned to a patient  

In the "Patients" pane, click the  button. You see the list of restorations currently 
stored for that patient.

Click on the restoration to activate it. Caution: If you have a restoration displayed 
on the screen (e.g. one you are currently designing) that has not been saved, 
you will lose that restoration when you retrieve an existing design.

If you have stored multiple restorative alternatives, you can easily compare them at a click 
of the mouse.

7.7              Renaming and deleting saved restorations  

Double-click the restoration that you wish to rename. Enter the new name and press Enter 
when you are finished.

Selecting and then right-clicking an entry with the mouse deletes a restoration. Pressing 
Del also deletes an entry.
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8 Working with document templates

To manage document templates, click the  icon or press the F8 function key or 
open the "Window" menu and select "Documents".

You can think of document templates as empty forms. What you essentially do is take a 
form from the drawer, then complete and file it. Be sure to always save a completed 
template under a different name than the original template, or else your 
original empty template will be overwritten when no longer be available to fill 
out!

Dental Explorer 3D already comes with a set of templates. Most of these templates already 
include a header, blank fields for your contact data and blank fields for the patient's 
address data.

For reasons of efficiency, we recommend entering the name of your practice of institution 
and your contact data in the templates you wish to use and then re-save the templates 
under the same name. To prevent the templates from being erased by saving over them, it 
is recommended to write-protect the templates.

The templates are located in the "\data\documents" subfolder of the Dental Explorer 3D 
installation folder. 

If there is no suitable template among those provided for the specific purpose, you can 
always create your own template using a word processor. Please save your templates in 
the same folder as the existing templates, so that Dental Explorer 3D can find them.

Document templates are especially well suited for compiling complex documentation with 
minimum effort. This means, for example, that you can create and save partial documents 
with predefined boilerplate copy. Once it is time to create your document, e.g. A proposal 
for your patient or a treatment plan for the patient's health insurer, all you have to do is 
insert the images created with Dental Explorer 3D in that template. For details on how to 
insert images in templates please consult section 13.

Dental Explorer 3D accepts documents created with Microsoft Word or with OpenOffice.
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9 Videos

9.1              Video playback  

To play a video, click the  icon or press the F6 function key or open the "Window" 
menu and select "Videos".

The list of available videos and animations will appear on the right side of the screen. Click 
on a video to play it, Videos are shown in their own window, which can be freely 
repositioned on the screen. In a two-monitor configuration, the video window can also be 
moved to the extra monitor.

All videos have soundtracks. Do not forget to turn your speakers.

Above the list of videos will see a number of flags. Click on one of the flags to choose 
between different languages to play the video in. You can even this do on the fly while the 
video is already running. Available languages include English, French, German, Italian, 
Portuguese and Spanish. 

Changing the language of the video will not affect the language of the user interface. This 
allows you to play a video in your patient's own language if it is different from your own.

At the bottom of the video window you will see a number of controls. The volume slide on 
the left controls the playback volume. Next to it you have the start/pause button that lets 
you pause and unpause a video. (The same pause/unpause effect can be achieved by 
pressing the space bar.) 

The circle in the progress bar that extends across the bottom of the screen can be 
dragged backward and forward on the progress bar to repeat or skip part of the video, 
respectively.
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9.2              Restoring the aspect ratio of the video window  

The size of the video window can be enlarged and reduced with the mouse, just like any 
regular window. Note, however, that this can change the aspect ratio of the video display 
and create a distorted view.

If you get a distorted view, open the "Help" menu and select "Reset Video Window". The 
video window is then restored to its correct aspect ratio.

9.3              Downloading and importing more videos  

Dental Explorer 3D supports downloading and importing other video files from the 
Internet. Updates and additions to Dental Explorer 3D are available exclusively from the 
Quintessence online store at www.quintessenz.de. These may be free or paid updates or 
additions.

For network installations of Dental Explorer 3D, note that video files can be imported to 
the server only. The import function is not available for the clients. Also, remember that 
you must exit and restart the program on the clients to access the new video files on the 
server.

If you want to expand your video library by availing yourself of this offer, download the 
respective file from Quintessence online store and place it in a folder or on your computer 
desktop.

Once this has been done, the video file must be decrypted and integrated into the video 
library of Dental Explorer 3D. To do so, open Dental Explorer 3D, open the "Help" menu 
and select "Add video files".

A pop-up import window will open. In the input field, enter the path name of the folder 
where you stored your downloaded video file, or click the "Browse" button to navigate to 
the file's location.

Open the file and click "Import" to decrypt the file. A progress bar will appear indicating 
the status of the decryption process. Finally, click "OK" to integrate the new videos into 
the standard video library structure of Dental Explorer D3.

The new videos are now available for playback from "Videos" menu.
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10 Examples

The "Examples" function lets you save restorations, restorative alternatives and complex 
designs within Dental Explorer D3 and retrieve them as needed. Unlike the restorative 
alternatives (see section 7.5), examples are not assigned to any particular patient but 
saved independently.

Examples are a great way to create a basic design, save it independently of the patient 
and retrieve it during the patient's visit, extending and modifying it and finally associated 
with the patient. Your basic design will be preserved in the process and will thus have to 
be created only once.

10.1            Saving examples  

On the main control bar, click the  button. You will be prompted whether to save your 
design "As example" or "With selected patient". Try entering a meaningful name that lets 
you distinguish different examples later. You can save an unlimited number of examples.

10.2            Retrieving examples  

To retrieve an example, click the  icon or press the F5 function key or open the 
"Window" menu and select "Examples".

You will see the list of available examples. Click on the example to activate it. Caution: If 
you have a restoration displayed on the screen (e.g. one you are currently 
designing) that has not been saved, you will lose that restoration when you 
retrieve an existing design.

10.3            Renaming and deleting saved examples  

Double-click the example you wish to rename. Enter the new name and press Enter when 
you are finished.

Selecting and then right-clicking an entry with the mouse deletes a restoration. Pressing 
Del also deletes an entry.
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11 Timer

To activate the timer, click the  icon or press the F9 function key or open the 
"Window" menu and select "Timer".

Zone 6 now displays the time. You will see the time in hours, minutes and seconds and the 
"Start" and "Stop" buttons.

Set the time by clicking on each of the pairs of digits for hours, minutes and seconds, then 
adjusting them with the arrow buttons. Of course you may also enter the time directly.

When the time is set, click "Start". The elapsed time is displayed numerically and as a 
progress bar. When the set time has been reached, an acoustic alarm is sounded.

To cancel the timer, simply click "Stop". 
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12 Internet

To access the Internet, click the  icon or press the F10 function key or open the 
"Window" menu and select "Internet".

Your default Internet browser will open and attempt to connect to

www.dentalexplorer.de.

provided a working Internet connection is present; if not, you will get an error message 
from your browser.

At www.dentalexplorer.de you will find:

• Facts and information on Dental Explorer 3D
• Program operation tips and tricks
• Numerous tutorials
• Answers to frequently asked questions (FAQ).
• Manuals, software updates, document templates and videos for downloading
• A form for asking support questions
• Directions for contacting the hotline
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13 Collecting and processing images (lightbox)

The lower part of the screen (zone 5, see section 2) contains the picture flow, a lightbox 
that can temporarily store (cache) screenshots of your work. These screenshots can be 2D 
or 3D views, different viewing angles of 2D or 3D views and even complete restorative 
alternatives. You can also produce a screenshot after each treatment step to document an 
entire course of treatment. There is no limit to the number of screenshots you can cache.

13.1            Adding images to the picture flow  

To cash a screenshot, click the  icon or press the B key or the F7 function key or 
open the "Window" menu and select "Screenshot". A thumbnail view of the restoration in 
its current status appears in the picture flow. If the picture flow already contains 
thumbnails, these will be shifted to the left, and the new thumbnail is shown in the centre 
of the area.

13.2            Scrolling through the picture flow  

All the screenshots you have cached will be shown in the picture flow area at the bottom 
of the screen. By clicking to the left or the right of the image in the centre, you can move 
the images in the corresponding direction. 

The image in the centre is always the one will be is selected for painting or for 
copying to your word processor!

13.3            Painting  

Clicking on the thumbnail in the centre will open the Paint window. The individual actions 
available here are described in section 14.

Click  or  to close the paint window and to restore the main window.
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13.4            Copying images to a word processor  

Images from the picture flow can be copied to a word processor. In your word processor, 
you can use the screenshot images to document the full treatment procedures and make 
the documentation available to the patient or the health insurer.

13.4.1         Copying by drag-and-drop  

You can copy your images to a different program by simply dragging them their. Proceed 
as follows:

a Open your word processor. Under Windows, this can be either Microsoft Word or Open 
Office. Under Mac OS, you can also use Pages.

b Use the taskbar to activate Dental Explorer 3D.
c Navigate the picture flow until the desired image is in the centre.
d Place the mouse pointer over the image in the centre, the press the left mouse button 

and hold it pressed.
e While keeping the left mouse button pressed, drag the image to the icon for your word 

processor on the taskbar. Since the thumbnail will be visible throughout the action, the 
icon may be hidden temporarily, but this will not affect the copying process.

f Keep the left mouse button pressed. Your word processor will open.
g Drag the image to the desired location in your document. Now release the left mouse 

button. The image will be positioned in your document.
h Now you can use the regular functions of your word processor to move or scale the 

image.

If you have a dual-monitor system, copying an image is even easier: Open Dental Explorer 
3D on one monitor and your word processor on the other. Then drag the desired image 
directly from the picture flow to the other monitor and into your word processor 
document.

Unfortunately you cannot transfer multiple images from Dental Explorer 3D to your word 
processor document at once. If you need to copy multiple images, you will have to repeat 
the above process for each image separately.
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13.4.2         Copying by way of a file  

If the route described in the previous subsection does not work for some reason, proceed 
as follows instead:

a Open the "Tools" and select "Save screen".
b In the new window that appears, select 

• the folder where the image is to be stored on the computer
• a meaningful filename
• the format in which the image is to be saved

c Now go to your word processor.
d Import the image you just saved. How this works depends on your word processor.

Please note that with this method, it is the original image from the main window that will 
be saved as a file and not the thumbnail.
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14 Painting

Clicking on a thumbnail in the picture flow activates Paint mode. You can now add 
differently coloured lines, circles, rectangles and other visual elements to your restoration. 
At the top of the main window you will see a number of additional controls, very similar to 
those used in many popular paint programs.

14.1            Controls, part 1  

The controls    have the following functions 
(left to right):

 Line Draws a straight line with the selected colour and line thickness

 Dots Draws a dotted line with the selected colour and line thickness

 Polyline Draws a line following your mouse pointer movements with the 
selected colour and line thickness

 Polygon Draws a polygon following your mouse pointer movements with the 
selected colour and line thickness

 Rectangle Draws a rectangle with the selected colour and line thickness

 Rounded rectangle Draws a rectangle with rounded corners with the selected colour 
and line thickness

 Ellipse Draws an ellipse or circle with the selected colour and line thickness

 Arc Draws an arc with the selected colour and line thickness

 Crop Lets you select a detail of the image. Place your mouse pointer at 
the top left corner of the desired cropping area, press and hold the 
left mouse button and draw a rectangle to delimit the cropped 
image.

Note: All the actions you perform while painting can be directly seen in the thumbnail 
within the picture flow.
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14.2            Controls, part 2  

The controls    have the following functions (left to right):

Save If you want to save the result of your painting effort to a separate file, 
click on the button with the diskette icon. You will see a dialog window 
where you can specify the target folder and file name of the image as 
well as the image format.

Print If you want to print the result of your painting effort directly, click on the 
button with the printer icon. Depending on your hardware, a print dialog 
will open where you may be able to define further parameters.

Undo Clicking this button lets you go back one step and undoes the effect of 
your previous action.

Redo Clicking this button restores the effect of an action previously undone.

Copy to 
clipboard

Clicking this button will copy the image including all edits to the clipboard 
for possible processing in a different application.

14.3            Controls, part 3  

The controls are (left to right): Line width, Foreground colour, Style, Pattern, and 
Background colour.

Line width Set the width of the lines or borders to a value on a scale from 1 to 20.

Foreground 
colour

Click the coloured square to set a different line or frame colour. Select the 
new colour from the dialog that opens.

Style Use this to determine what line or border style you want.

Pattern Use this to determine what filling pattern you want for the inside of the 
element.

Background 
colour

Click the coloured square to set a different colour for the inside of the 
elements. Select the new colour from the dialog that opens.
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15 Printing

The printing option has already been mentioned throughout the various sections of this 
manual. They are listed here again for the sake of completeness:

Printing a single image from 2D view Click the  button.

Printing a single image from 2D view Press the P key on the keyboard

Printing a single image from 2D view From the "Tools" menu, select "Print screen"

Printing a single image from 3D view Press the P key on the keyboard

Printing a single image from 3D view From the "Tools" menu, select "Print screen"

Printing an image that has been 
modified in Paint mode

Click the printer icon at the top of the paint menu

Printing multiple images Copy the thumbnails of the files to your word 
processor and then print the resulting document 
(see Section 13.4)
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16 Rearranging the windows

Dental Explorer 3D consists of an array of windows. If you do not like the layout, you can 
change it as you wish. For example, on a dual-monitor system, it may be prudent to move 
the restoration window and the patient window to the second monitor to make more room 
for the main window.

First, select "Show title bar" in the settings. All panes of Dental Explorer will now get their 
own title bars with additional "Detach" and "Close" controls. The panes can now be 
detached from the composite window and moved to the different location or even to a 
different monitor.

For example, if you like to work with function keys only, you may completely close the 
window containing the icons (usually located on the left side). It is also possible to move 
the "picture flow" to the right third of the screen. These two actions allow you to display a 
significantly larger Dental Explorer 3D main window.

Once you have created a layout that you like, you should save it. If, however, you find that 
you made a mistake, use "Layout" > "Reset layout" to restore the familiar layout – unless 
you happen to have accidentally overwritten the "default" or "minimal" basic layouts.

When you save you will be prompted for a name for your current layout. Enter a 
meaningful name, as you will have to remember this name, should you wish to restore the 
layout.

Finally, it is possible, by pressing and holding the left mouse button, to shift the orange 
flashing bars to give individual panes more or less space. However, each pane has a 
certain minimum width or height, depending on the resolution of your monitor, so you 
cannot reduce it to a size smaller than that.
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17 Importing patient data from practice management 
software

17.1            Activating the Dental Explorer 3D interface  

To activate (publish) the interface of Dental Explorer 3D on your computer, select 

Help > Publish interface

from the main menu. You only have to do this once per installation. Note that this requires 
running the program with Administrator privileges. If you have any doubt, contact your 
system administrator. – Dental Explorer 3D is now ready to receive patient data and 
findings.

17.2            Data transmission via the interface  

The actual data transfer process is initiated from the practice management software. 
Dental Explorer 3D serves as a tool for visualization. For information on how to initiate the 
data transfer, please consult the documentation of your practice administration software, 
where you will also find the information required to activate the practice management 
software interface.

17.3            Displaying transmitted data  

If the Dental Explorer 3D is not running yet, the data transmission process will start it 
automatically. If the patient in question is already present in the database, the patient 
record will be opened; if not, a new patient record will be created. At the same time, a 
new entry will be created in the list of restorations. Click this entry to visualize the 
transmitted data on the cast.

Click  to toggle between patient data and restorative alternatives.
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18 Deregistering the program

You cannot use a single-user licence to run DE3D on multiple computers concurrently. For 
customers who want to use Dental Explorer 3D on different computers (such as an in-
office and a notebook computer), you can use the same serial number on one or the other 
computer (but not both at the same time).

To be able to use the software on computer B, you must first deregister the software on 
computer A. To do so, proceed as follows:

Step #1: From the main menu of the software, select "Help" > "Unregister".

Step #2: A new window will appear. Click "Continue".

The program is now deregistered and will terminate automatically. You can now use the 
same serial number to register the software on a different computer. 

If your computer is not connected to the Internet, you must perform deregistration on a 
computer that has Internet access. To do so, proceed as described under "Registering 
without being connected to the Internet" above.

19 Uninstalling the program

From the Windows start button, select Programs > DE3D > Uninstall DE3D.

You will be prompted to confirm the uninstall command. Once confirmed, Dental Explorer 
3D will be uninstalled. Only the registration data and the patient database will remain on 
your local drive for backup purchases. Note that the patient database PATIENT.DB will be 
renamed by prefixing the uninstall date to the filename. If you plan to reinstall the 
program and want to access the old data, delete the newly created PATIENT.DB file and 
rename the backup file with the uninstall date to PATIENT.DB.
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20 Legal information

All title and copyright to Dental Explorer 3D (including but not limited to illustrations, 
photographs, animations, video and audio components, music, text and the integrated 
Dental Explorer 3D applets) and all copies of Dental Explorer 3D are the property of 
Quintessence Publishing or its suppliers. Dental Explorer 3D is protected by national and 
international treaties and copyright legislation. Dental Explorer 3D must be treated like any 
other copyrighted material.

You may permanently assign your rights to a third party, provided that you retain no 
copies and that the entire Dental Explorer 3D product (including all components, data 
media, printed materials and possibly the COA) is transferred to the recipient. If the 
Dental Explorer 3D in question is an upgrade product, you must also include all previous 
versions of Dental Explorer 3D in the transfer.

The production and reproduction of screenshots for purposes of patient education, the 
printing of screenshots as evidence for insurance companies and the creation and printing 
of custom patient brochures for internal use is generally permissible even without the 
express written or oral consent of Quintessence Publishing, provided that proper 
attribution is made (© W. Kohlbach – Dental Explorer – Quintessence Publishing, Berlin). 
The same is true for using and printing screenshots for presentations used in training or 
continuing education.

The production and reproduction of screenshots for printing or reprinting in newspapers, 
magazines, books or journals and the publication of screenshots on the Internet (including 
but not limited to advertising purposes) is generally prohibited without the express written 
consent of the author or Quintessence Publishing. This consent, if any, will only be given if 
proper attribution is made (© W. Kohlbach – Dental Explorer – Quintessence Publishing, 
Berlin).

Copying or public performance of the videos or deploying them on the Internet is strictly 
prohibited.

Without prejudice to any other rights and provisions, Quintessence Publishing may revoke 
the licence agreement if you violate its provisions. Should this happen, you must destroy 
all copies of Dental Explorer 3D and its components.

Third-party brands and product names mentioned in this document are recognized as 
trademarks of their respective owners. Any mention of products offered by entities other 
than Quintessence Publishing is for informational purposes only and does not constitute an 
endorsement. Quintessence Publishing does not accept any liability related to the 
selection, performance or use of these products.
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